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(For IT-550) CODE : I1000153000

INSTRUCTION MANUAL

Before using the INFRARED THERMOMETER,
throughly read this manual for the proper operation.
After reading, keep this manual for future reference.

Unauthorized copying and reproduction of
this Instruction Manual is forbidden.
c Copyright HORIBA, Ltd. 1999

Printed in Japan



Welcome to HORIBA's Expansion Kit for the IT-550 series infrared
thermometer.
This instruction manual has been prepared for those who will handle the
product. The person handling the product is assumed to
●have a basic knowledge of the personal computer being used.
●be able to operate the computer mouse.
●be capable of basic operations, such as opening/closing windows.
●be able to move to the target folder (directory) from the current folder

(directory).
For a detailed explanation of these procedures, refer to the instruction manual,
etc. that came with your personal computer.
For handling the IT-550, refer to the instruction manual that came with the IT-
550.
For correct and safe operation of this expansion kit, carefully read this manual
prior to use.

If the following cautions are not observed, the expansion kit may be damaged
or may malfunction.
●The expansion box is not dustproof or splash-resistant. Do not use the kit in

a place where dust or water will get on it. Also, the IT-550 is not dustproof or
splash-resistant when the modular cable is connected.
●Do not bend or stretch the cable with extreme force.
●When connecting/disconnecting the connector, be sure to hold the connector

portion. Pulling the cable portion may damage the connector.
●If Windows 95TM is operated continuously for more than one month, it may

stop for several hours. Although Windows 95TM automatically recovers, the
data cannot be collected while the system is down.Therefore, Windows NTTM

is recommended for continuous data collection.

Please note the following limitation before using this product.
HORIBA, Ltd. will assume no responsibility for damage to data resulting from
the breakdown of this product or the wrong operation of the product by you or
a third party.

Introduction

Caution

Limitation of responsibility
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Chapter 1

●Software for personal computer (TEMP Utility)
Floppy disks: 4 (2 disks for Japanese version and 2 disks for English
version)
●Expansion box (EX-5): 1
●Modular cable:１
●Analog output cable:    1
●Ferrite core:   2   Large 1 (for analog output cable)

Small 1 (for modular cable)
● Instruction manual (this manual) :    1

It is recommended to attach a ferrite core to each cable to prevent any
influence from electromagnetic waves.

CE marking is obtained in the state where the ferrite core is attached to the
cable.

Wind the cable double, and attach the ferrite core as close to the IT-550 side
connector as possible.

Like the modular cable, wind the analog output cable, RS-232C cable or AC
adaptor cable double around the ferrite core (large), and attach it as close to
the expansion box side as possible.
When the analog output cable, RS-232C cable and AC adaptor cable are
used, obtain a ferrite core ZCAT 3035-1330A (manufactured by TDK)
separately from a personal computer store.

Prior to use

Attaching the ferrite core

○Modular cable

○Analog cable, RS-232C cable and AC adaptor cable

IT-550 side

Ferrite core (small)

Note

Contents of the kit
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Chapter 2

Purchase the RS-232C cable and the printer cable from a computer shop.
Refer to 3.1 "Connecting the personal computer" and 4.1 "Connecting the
printer."
Use of the wrong connection (cross connection vs. straight connection) with
the RS-232C cable will damage to IT-550.
Carefully confirm all connections prior to connecting to the expansion box.

Configuration

IT－550F

Personal computer

AC adapter
(sold separately)

Modular cable
▲

Expansion box 
(EX-5)

RS-232C cable 
(cross)

RS-232C cable (straight or cross)
according to printer specifications

Connect to personal
computer or printer

Printer

Personal computer

AC adapter
(sold separately)

Analog voltage
output cable

Recorder

Modular cable

IT-550F (for field use)

IT-550L/S (for laboratory use)

Caution

RS-232C cable (straight or cross)
according to printer specifications

Expansion box 
(EX-5)

IT－550L/S
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○Required items:
●IT-550F, IT-550L or IT-550S main unit ● Personal computer
●Expansion kit (expansion box, modular cable, software floppy disks)
●RS-232C cable (cross connection)

○RS-232C cable selection
●Connect the RS-232C cable to the connector indicated as RS-232C on

the expansion box and to the COM port of the personal computer.

The RS-232C cable has two types of connectors: straight and cross.
A cross connection RS-232C cable is used to connect the expansion box
to the personal computer.(Refer to figure below.)
An RS-232C cable can be obtained at a personal computer store. Please
purchase the type conforming to your computer.

9-pin connector at PC side: 
A D-SUB 9P female cross cable is required for both.

○Connecting cables

３.１ Connecting to the personal computer

Use of Personal Computer (common to IT-550F/L/S)

9-pin male connector

Expansion box

Personal computer (back)

Modular cable
Thermometer (connector)

Chapter 3

The COM port of the personal computer is the connector for
communication with external equipment, such as a modem. In most
cases, the computer has two male connectors of nine protruding pins
at the back or one connector (for notebook-type personal computers). 

RS-232C cable 
(cross connection) 

２�
３�
４�
５�
６�
７�
８�

Frame

D-SUB�
9P

D-SUB�
9P

２�
３�
４�
５�
６�
７�
８�
Frame
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Chapter 3

Confirm or understand the following before starting
installation:

●"TEMP Utility" is a product of HIOKI E.E. CORPORATION
●The reproduction, copying, or alteration of part or all of the "TEMP Utility"

for any purpose other than controlling the infrared thermometer or
processing the data is prohibited by law.
●The "TEMP Utility" may be changed or upgraded by HIOKI E.E.

CORPORATION without notice.
●When the "TEMP Utility" is to be quoted in a published work, prior

permission from HIOKI E.E. CORPORATION is required. Further, use of
the trademark "HIOKI" is not permitted.
●HIOKI E.E. CORPORATION or HORIBA,Ltd. will assume no responsibility

for the resulting operation of the "TEMP Utility" by the user.
●Internet Explorer Ver. 4.00 or more is required.

Floppy disks
●Do not drop, bend or mishandle the floppy disks.
●Do not put the floppy disks in a place where they will be exposed to direct

sunlight, near a strong magnetic field, or close to a heating device.
●Do not get the floppy disks wet.

３.２.１ General specifications of TEMP Utility
Media: Four 3.5-inch 2HD (1.44 MB) floppy disks (two disks for
Japanese version, two disks for English version)

(1)Operating environment
Main unit: Personal computer with CPU of i486DX4 or more

that operates with Windows95TM, Windows98TM, or
WindowsNTTM4.0
Internet Explorer Ver. 4.00 or more

Memory: 16MB or more
Display: Resolution 800x600 dots, 16 colors or more
Hard disk: At least 4MB free space

(2)Recommended operating environment
Main unit: Personal computer with a Pentium 120MHz CPU or

greater that operates with Windows95TM,
Windows98TM, or WindowsNTTM4.0
Internet Explorer Ver. 4.00 or more

Memory: 32MB or more

Display: Resolution 800x600 dots, 16 colors or more

Hard disk: At least 4MB free space

Caution:

３.２ Installing the software on your personal computer
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Registered trademark
●Windows is the trademark of Microsoft Corporation, USA
●i486DX4 and Pentium are trademarks of Intel Corporation, USA
●Other product names are the trademarks or registered trademarks of

following companies:

Copyright c 1987-1997 Microsoft Corporation, all rights reserved.
Copyright c 1998 HIOKI E.E. CORPORATION

As regards the latest information on version up etc., refer to the URL.
http : //www.horiba.co.jp

３.２.２ Installation

All programs should be closed. 
If a power failure occurs or power to the computer is turned OFF during
execution of Setup.exe, data stored on the hard disk may be damaged.

Insert Disk 1 of
TEMP Utility
(English) into the
floppy disk drive.

Double-click My
Computer on the
desk top, and
then double-click
the icon 31/2

Floppy (A:).

Caution

Chapter 3

１

２

Note
On this instrument, communication is checked using the following personal
computers.
If any troubles should occur during communication, please contact us.
VM516S(EPSON), Vectra VL2 4/33S(HP), Optiplex GXPRO(Dell)
Satellite 315CDT(TOSHIBA), ClienPro XVI(Micron), Lavie NX(NEC)
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Chapter 3

４

５

Double-click Setup.exe on the disk. The following dialog box
appears.

Install TEMP Utility in accordance with the instruction on
the screen.
In some cases, you may be requested to restart Windows during
installation.
Remove the floppy disk, and restart in accordance with the
instructions on the screen.
When WindowsTM restarts, perform installation from the beginning.

Confirm that installation has been completed correctly.
(The TEMP Utility icon is created in
the sub-menu Programs of the
WindowsTM Start menu.)

３
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Make sure that the button on the
infrared thermometer main unit
shown at right diagram is  P .
※ If this button is a     , refer to the

explanation for the the laboratory
use thermometer (see p. 15).

Memory data reading involves the
following functions:
●Reading memory data

Reads the memory data
measured with the IT-550F to the personal computer.
●Displaying the memory data list (see p. 11)

Displays the measurement start and end time, the memory data
number, the maximum value, minimum value, and average value for
each data No. of memory data.
●Data table (see p. 12)

Displays the measured data for each data No., and  Hi/Lo can be
judged by inputting the upper and lower limit.

３.３.１ Basic usage

Reading the memory data measured with the IT-550F to the
personal computer.

Start up the Read Memory Data
①The TEMP Utility icon is created in the sub-menu

Programs of the WindowsTM Start menu.
The TEMP Utility [Start Up Menu] screen is displayed.

T ▼�

MEAS

▲�

C P

P

Chapter 3

１

３.３ Reading memory data (for IT-550F only)

Reading memory data
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② Select the Read Memory Data button.
Reading of the memory data starts.

Set communication
Select COM port to enable communication.
Select the COM Port menu in the Settings menu from the menu bar.
Select COM port connected to the infrared thermometer from COM1
to COM4.
If you do not know which COM port the infrared thermometer is
connected to, select COM1 or COM2 under normal operation.

Chapter 3

２
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Check communication
When the infrared thermometer
is connected to the personal
computer and communication
setup has been completed,
confirm communicability.
Select the Confirm Connection
in the Settings menu from the
menu bar. Operation in
accordance with the instructions
allows you to check the
communicability.
If the connection is incorrect, change the COM port and check again.

Read thermometer memory data to the personal computer
Select the Read Memory Data button to confirm that the memory
data of the IT-550F has been transmitted to the memory data list.

If there is a large discrepancy between the date set in the IT-550F main unit
and the date set in the personal computer (more than one month), dates on
the personal computer may not be displayed correctly.

Ending
Select the Exit button.
TEMP Utility is closed.

４

５

Clearing the memory data of thermometer
The memory data of thermometer can be completely cleared using the
personal computer. Select  the Clear Memory Data menu in the
Memory Data menu from the menu bar.

Chapter 3

３

Note:
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Chapter 3

Making good use of the data with your personal computer

Memory data for the IT-550F is managed according to blocks named for
data No. A maximum of 130 readings can be stored in the memory for
any data No., and the available data Nos. are 1 to 64.
However, the total number of data readings that can be stored for all the
data Nos. combined is 130.
In the Memory Data Table, the title, start time and stop time, the number
of memory data, maximum value, minimum value, average value, and
the person taking the measurements are displayed for each memory
data No. 

Enter the title and the person taking measurements
in the measurement data.

The title and the person taking the measurements can be entered in the
Memory Data Table.
The reliability of the measured data increases when the title and the
person measuring in responsible for the measured data entered. It is
recommended to enter these items without fail.
Double-click on the Title cell of each data No. or the Meas. Person cell
in the Memory Data Table. Enter the text, and hit the Return key.

No.

Title
Start time

Stop time

Number of
data

Max. / Min. /
Ave. values

Memory Data Table

３.３.２ Data processing

Person taking
measurements

Note
When the measured value is beyond (or under) the display temperature
range, the upper limit 505℃ (or the lower limit －55℃) is input as the data.
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The measured data for each data
No. can be viewed by displaying
the Data Table.

When the Data Table menu in the
Memory Data menu is selected,
the Data Table display can be
switched ON/OFF.

Selection of the data No.
displayed

Click on the cell of the data No.
to be displayed in the Memory
Data Table.
When the number is selected,
the color of the number portion at
the far left of the table changes.
The measured data of the selected data No. is shown in the Data Table.
Clicking on the ▲ button in the Data Table displays the Data Table of the
previous data No. and clicking on the ▼ button displays the Data Table of
the next data No.

Judgment function
The Data Table has a place to enter the upper limit value and lower limit
value. By entering numerical values in this cell, the measured data can be
judged. Judgment results are
displayed in the Judg. column of
the Data Table.
Hi : Displayed when the
measured value is above the
upper limit value.
Lo : Displayed when the
measured value is below the
lower limit value.
When the measured value is
within the range, nothing is
displayed.
If "-" is entered in the input
section of the upper limit value or
lower limit value, the respective
judgment function is ignored. If "-
" is entered in both input cells,
the judgment function is turned
OFF.

Judgment value

Max. value (red)

Min. value (blue)

Data Table

Chapter 3
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Chapter 3

The measured data of all data Nos. are collectively saved in one file.
Select the Save As menu in the File menu from the menu bar. Enter the
file name or select the file, and select the  Save  button. The data is
saved.
To update the file after having changed the title or the measuring person
with the data read from the file, select the Save menu in the File menu
from the menu bar. The file is saved in CSV format (text file punctuated
with commas).
Saving of data with many numbers may take a long time.

Select the Open menu in the File menu from the menu bar. Select the
file name, and select the  Open  button to start reading.

The measured data of all data No. is collectively printed.
Select the Page setup menu in the File menu from the menu bar. Set
selection of printer and paper size.
Select the Print menu in the File menu from the menu bar. The printing
dialog box is displayed. Make the necessary settings, and print.
Selecting the  Print  button also starts printing.

It is not possible to print the data of the Table only or of each data No.
individually.

Saving the measured data in a file

Reading the measured data from the file

Printing

Note

３.３.３ Saving or reading the file and printing
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Chapter 3

Date, time, and emissivity of the
IT-550F main unit can be set from
TEMP Utility.

Select the Clock Setting menu in the
Settings menu .
Set the time, and select the OK
button. The data is transmitted to the
main unit, and the time is set.

Measurement setting for transmitting
to the infrared thermometer
Select the Settings menu in the
Setting menu.
The main unit Settings screen
appears.

Emissivity setting

To set the emissivity, enter the
numerical value directly or select from the list.
Setting range is 0.10 to 1.00 with a resolution of 0.01.
Selecting the Edit button allows you to edit the contents.

Editing the Emissivity lists

A total of ten emissivity lists can
be registered.

Adding:
Click on the portion to be added
in the list.
Type in the content to be added
in the input cell for material
and/or emissivity, and select the
Add  button.

Deleting
Click on the item to be deleted
from the list.
When the  Delete  button is
selected, the item is deleted.

Changing
Click on the item to be changed in the list.
Type in the content to be added in the input cell for material and/or
emissivity, and select the  Edit  button.

Setting the main unit clock

Main unit setup

Emissivity

３.３.４ Main unit setup
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Chapter 3

Make sure that the button of the infrared
thermometer main unit shown at right diagram is  .
※ In case of   P  , refer to Field use (page 8).

Real-time measurement has the following functions:

●Real-time measurement
Connected to the infrared thermometer through
RS-232C, it reads the measured data to the personal computer in real
time and stores the data in the memory.
●Displaying 8-channel data table (see p. 20)

It is possible to display a maximum of 8 channels of the real-time measured
value data and the measured data read from the file as data tables.
●Graph display (see p. 26)

It is possible to display the read data for a maximum of 8 channels.
Scale for time axis and temperature axis, and optional zooming are possible.
Reading of the value by cursor and statistic calculation for cursors are
possible.

３.４.１ Basic use 1 (Real-time measurement)

It is possible to connect the infrared thermometer to the personal computer
using an RS-232C cable, read the measured data at real time, and store it
in your personal computer.

M ▼�

MEAS

▲�

■� /

/

Real-time measurement

１

３.４ Real-time measurement (for IT-550L /S)

Note
● Do not touch the buttons on the infrared thermometer main unit  during

the real-time measurement. the operation  may cause any data is read
as 0.0.  Stop  the real-time measurement before changing the main unit
settings.

● Do not operate the mouse on TEMP Utility and Excel during the real-time
measurement. The operation may cause data omission.
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② Select the Real Time Measurement button.
Real-time
measurement
starts.

Set the communication
Select COM port to enable communication.
Select the COM Port menu in the Settings menu from the menu bar.
Select the COM port connected to the infrared thermometer from
COM1 to COM4.
If you do not know
which COM port the
infrared thermometer
is connected to,
select COM1 or
COM2 under normal
operation.

Check the communication
When the infrared thermometer is connected to the personal
computer and communication setup has been completed, confirm
communicability.
Select the Confirm
Connection menu in
the Settings menu
from the menu bar.
Operation in
accordance with the
instructions allows
you to check the
communicability.

If the connection is
incorrect, change the
COM port and check
again.

２

３

Chapter 3



Read the measured data of the thermometer into the personal computer
①Select the memory storage CH

Press the Real Time Measurement button or select the Real Time
Measurement menu in the Measurement menu. The Real Time
Measurement Select CH screen is displayed.
Select the CH No. to which the measured data is read, and select
the OK button.
The color of the selected CH number at the far left of the list changes.

②Set the conditions for real-time measurement.
When the Measurement Time Setting screen is displayed, set up
as follows:

(1) Interval setting
Decide the interval (measurement interval) by selecting the
figure and unit.

(2)Logging time setting
Similarly, decide the logging time (measurement time) by
selecting the figure and unit. When "Continuous" is selected,
measurement continues until it is stopped manually. When
"Continuous" is selected, the figures cannot be input.
Further, if "Times" is selected, measurement is performed only
for the count that was set. Measurement count includes the

17

Timer Measurement
Load To Excel

Logging Time
Interval Time

Chapter 3

４
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measurement start time as one time. The measurement time
interval is the time set in Interval Time.

(3)Timer measurement
When performing timer measurement, check the "Timer Start"
check box in the Measurement Time Settings dialog box. When
the check box is checked, the Timer Settings screen appears
automatically. To change or confirm the timer time later, select
the "Timer Settings" button next to the "Timer Start" check box.
The Timer Settings screen is displayed.

Timer setting

Measurement start time and stop time or measurement time can
be set with the Timer Settings screen. For the measurement
stop time, specify the end time directly or set with the
measurement t ime. If "Continuous" is selected for the
measurement time, measurement can be stopped manually
when it was started with the timer.

(4)Option of reading to Excel
This option is valid if Microsoft Excel software has been
installed.
When the "Load to Excel" check box is checked, the measured
value can be read to an Excel table in addition to normal real-
time measurement.

Chapter 3

Note
Excel 97 or later should be used to load 16383 or more data with this option.
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③Starting the Real Time Measurement
After setting the interval and logging time, select the OK button in
the Measurement Time Settings screen, and proceed in
accordance with the instructions to start measurement.
The screen displays the Real Time Measurement window for the
measured values and the data table to which the measured values
are stored.
When the option of reading to Excel is specified, Excel starts
automatically and the data is read to a new BOOK sheet.

④Stopping the Real Time Measurement
Selecting the Stop button stops the real-time measurement.
Measurement results up to this time are displayed in the
measurement data CH list and the data table.

Chapter 3
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With Monitor measurement, the measured data is read in real time from
the infrared thermometer at an interval of one second, and displayed on
the screen. As the measured data is not stored, this measurement can be
performed easily if operation check or recording is not required.
To start Monitor measurement, select the Monitor Measurement button or
select the Monitor menu in the Measurement menu from the menu bar.

３.４.３ Data processing
Making use of the data with your personal computer

The real-time measurement
measured value data or data read
from the file are displayed in the
Table of Data CH. It can be
displayed also as each data table
up to a maximum of 8 channels.
Also, the maximum value, minimum
value, and average value of the
data are calculated and displayed.

Enter the title and person taking measurements in the
measurement data.

The title and the person taking measurements can be entered in the
Table of Data CH.
The reliability of the measured data increases when the title and the
measuring person as the responsible person for the measured data are
entered. It is recommended to enter these items without fail.
Double-click on the Title cell of each data No. or the Meas. Person cell
in the Table of Data CH. Enter the text, and hit the Return key. Entry is
not possible in a CH that has no measured data.

Monitor measurement

Chapter 3

Table of Data CH

３.４.２ Basic use 2 (Monitor measurement)

Note
When the measured value is beyond (or under) the display temperature
range, the upper limit 505℃ (or the lower limit －55℃) is input as the data.
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The measured data of each CH by real-time measurement can be viewed
when the data table is displayed.
Selecting the CH1 menu in the Data table menu allows you to switch the
data display ON/OFF. A maximum of 8 channels can be displayed at one
time.

Chapter 3

CH  No.

Title
Start time

Stop time

Number of
data

Max. / Min. /
Ave.values

Person taking 
measurements

Data table
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①Select the CH to be saved.
Select the Save As menu in the File menu from the menu bar. Select
the CH to be saved in the File Save Select CH screen, and select the
OK button.

If you try to select a CH that contains no data, an error
message is displayed.

②Store the measured data.
Enter the file name in the Save As screen or select the file and select
the Save  button. The data is saved.
To update the file after having changed the title or the measuring person
with the data read from the file, select the Save menu in the File menu
from the menu bar. The file is saved in CSV format (text file punctuated
with commas).
Saving of data with many numbers may take a long time.

①Select the CH to be read.
Select the Open menu in the File menu from the menu bar. 
Select CH to be read on File Open Select CH screen, and select the
OK  button.

Chapter 3

Saving the measured data in the file

Note:

Reading from the file of the measured data

３.４.４ Saving or reading of the file and printing
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②Reading the measured data
Enter the file name in the Open File screen or select the file and select
the  Open   button. The data is read.
If the number of data is large, it may take a long time to load.

①Select CH to be printed.
The measured data of each CH is printed.
Select the Page Setup menu in the File menu. Set selection of printer
and paper size.
Select the Print menu in the File menu. Select CH to be printed in the
Print Out Select CH screen, and select the  OK  button.

②Print the measured data.
When the print screen is displayed, make the required setting and
start printing.

It is not possible to print the data of all CH at one time.

Chapter 3

Note:

Printing
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Resolution, emissivity, and scaling of the analog voltage output of the IT-
550L/S is main unit can be set from the TEMP Utility.

Each set value to be transmitted to the infrared thermometer is set.
Select the Settings menu in the Setting menu from the menu bar. Settings
screen
appears.

(1)Resolution
Select 0.1℃ or 1℃ for measurement resolution.

(2)Emissivity
To set the emissivity, enter the numerical value directly or select from
the list.
Setting range is 0.10 to 1.00 with a resolution of 0.01.
Selecting the  Edit  button allows you to edit the content of the list.

Editing the Emissivity list
A total of ten emissivity lists can be registered.

Chapter 3

Resolution

Emissivity

Analog Output Scaling

Main unit setup

３.４.５ Main unit setup
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Adding:
Click on the portion to be added in the list.
Type in the content to be added in the input cell for material and/or
emissivity, and select the  Add  button.
Deleting
Click on the item to be deleted from the list.
When the  Delete  button is selected, the item is deleted.

Changing
Click on the item to be changed in the list.
Type in the content to be added in the input cell for material and/or
emissivity, and select the  Edit  button.

(3)Analog output scaling
Set the temperature corresponding to zero output and full-scale output
of analog output.
Setting range is -50℃ to 500℃ with 1℃ resolution.
However, the difference between the zero and full-scale values should
be set 10℃ or more.

Selecting the  Send Settings  button transmits the set values to the main
unit.

Selecting the  Receive Settings  button allows you to read the main unit
present various set values.

Chapter 3

Main unit setup transmission

Main unit setting reception



26

The data read from a maximum of 8 channels can be displayed in a
graph simultaneously. It is possible to change the scale of the time axis
and the temperature
axis, and free zooming.
It is also possible to
perform readout of the
values and statistical
calculation between
cursors.

Select the Graph menu
in the Graph menu from
the menu bar to display
the TEMP Utility [Graph]
screen.

Select the Time axis setting menu in the Graph menu from the menu bar.
When [Auto Ranging] is
selected, the time axis is
automatically set so that
all measured data are
contained in the display
screen.
By selecting the Display
A-B Range, the sub-
menu portion between
cursors A and B is
magnified and displayed.
When the time of [1Sec],
[5Sec] ... is selected, one
scale on the graph is
used as the selected
time.

Chapter 3

Setting the time axis

Time axis

Before starting real-time measurement or during real-time
measurement, select the Graph menu in the Graph menu from the
menu bar, and execute real-time measurement. Measurement can

be performed while plotting the present value on the graph.
But, as operation may become unstable, do not overlap other screens on the
graph.

３.４.６ Graph display
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When the Time axis is set to [Elapsed time], the time axis displayed
shows the time passed from measurement start.
To show the measurement time of each channel, select the CH No.

Select the Temp axis
setting menu in the
Graph menu from the
menu bar.
When Auto Ranging is
selected, the
temperature time axis is
automatically set so that
all measured data are
contained in the display
screen in the time axis
range displayed on the
screen.
By selecting the Temp
Display Range..., the
display range of time axis
can be set.
When a temperature like
[0.1℃], [0.5℃] ... is
selected, one scale on
the graph is used as the
selected temperature.

Press the right button of
the mouse while in the
graph screen to select
the zooming rate from
[Zoom Time] and [Zoom
Temp].
By selecting [Mem
Scale], the zooming rate
of the time axis and
temperature and graph
display position can be
memorized by No. (max.
of 5)

Chapter 3

Temperature axis setting

Zoom
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While pressing the left mouse button, drag the portion to be zoomed on
the graph screen and select the range.
When selected, press the right button of the mouse at that spot and
select the Zoom Selected Area menu. To return to the previous state,
press the right button of the mouse on the graph screen to select the
Zoom Back menu.
Selecting the Zoom Selected Area menu in the Graph menu or the Zoom
Back menu in the Graph menu performs the same operation.

For long-term data collection, the cursor position from the present
display position in the specified time can be displayed quickly.
Set the display position of the waveform in time axis direction.
Selecting the Move Time Axis menu in the Graph menu from the menu
bar displays the setup screen.
You can choose to set the time directly or by cursor (A or B) position.

Two cursors (A and B) are used: the red cursor is cursor A and the blue
one is B. The cursors can be moved only in the block that contains the
data.
Information for the cursor is displayed in two tables on the right side of
the screen.
The upper table displays the cursor time, reading value of each
channel's measured value and statistical calculation values between
channels.
The lower table displays the statistical calculation values for each
channel between cursors A and B.

Chapter 3

Arbitrary zooming range

Setting Waveform display position

Cursor
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The cursor also has the functions listed below.
・Zooming the time axis of the graph between cursors A and B
・Moving the waveform display position to the cursor position

To move the cursor, the following three ways are used:
・Operate the cursor scroll bar.
・Directly drag the cursor on the graph screen.
・Select the Move Cursor menu in the Graph menu from the menu bar

to move the cursor  to the specified time.

Chapter 3

Moving the cursor

Cursor A (red) Cursor B (blue)
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ON/OFF or the color of lines on the graph display of each channel can
be specified.
Selecting the CH Settings menu in the Graph menu displays the CH
Settings screen.

Display of grid lines on the graph can be turned ON/OFF. Select the Grid
menu in the Graph menu from the menu bar to turn ON/OFF.

By selecting the Copy menu in the Edit menu from the menu bar, the
displayed graph is copied to the clipboard as bit map data.
The graph copied to the clipboard can be pasted to other applications,
such as word processing software.

The displayed graph can be printed.
Select the Page Setup menu in the File menu from the menu bar to set
selection of printer and paper size.
Select the Print menu in the File menu from the menu bar. Make
necessary settings on the print screen displayed and start printing.

Chapter 3

Graph copying

Graph printing

Grid setting

CH settings

Color setting
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Using the printer (for IT-550F only)Chapter 4

○Required items:
●IT-550F main unit ●Printer
●Expansion kit (expansion box, modular cable)
●RS-232C connection cable

○RS-232C cable selection
The IT-550F for field use is equipped with an RS-232 interface (with busy signal). It
can be connected to a printer for which the following settings are possible:
●Bits per second  :  2400
●Data bits  :  8               start, stop bits : 1
●Parity  :  None

When CR function can be set, set to "CR ignore" or "Return only".
(Field type outputs CR+LF for every line.)

To connect to the field type, use the cable specified in the table below.

※１　Expansion box can be connected directly without using this cable.
(In this case, remove the hexagonal stay from the connector on the expansion box side.

Printers not equipped with an RS-232C interface cannot be used.

４.１ Connecting the printer

Printer model (example)
DPU-201GS

(Seiko Electronics)

DPU-411
(Seiko Electronics)

Printer side connector type
D-SUB 9-pin 

(male)

D-SUB 25-pin 
(female)

Printer side connector signal
3: Data input (DATA)
5: Ground (GND)
8: Ready to Send (BUSY)

2: Data input (DATA)
7: Ground (GND)
5: Ready to Send (BUSY)

Cable specifications
D-SUB 9-pin (female)
←→9-pin (male)

Extension
cable
※１

D-SUB 9-pin (female)
←→ 25-pin (male)

Straight
cable

Printer

Expansion box

Modular
cable

IT-550F
thermometer
(connector)

RS-232C
connecting cable

Caution:

○Connection
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After checking that the
printer is connected to the
thermometer main unit as
illustrated on the previous
page, turn ON the printer and
thermometer main unit.
Pressing the   MEAS   button
momentarily will turn ON the
main unit.
The power is turned OFF
automatically when no
operation is performed for 15
seconds (except when
printing).

Pressing  P  button one time
starts printing of the data.
"Prn" blinks on the thermometer
display.

Prn blinks

Memory data is sent to and
printed on the printer. All
memory data will be printed.

T ▼�

MEAS

▲�

C P

T ▼�

MEAS

▲�

C P

１

２

３
Printing example

Chapter 4

４.２ Printing thermometer memory data
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Connecting the Recorder (for IT-550L /S)Chapter 5

○Required items:
●IT-550L/S main unit
●Recorder
●Expansion kit (expansion box, modular cable, analog voltage output

cable)

The IT-550L/S type uses an expansion box, modular cable, and analog output
cable. By connecting to the recorder, it can record changes in the measured
values. Analog output is 0 to 1V. Further, by setting the analog output scale of
the IT-550L/S, the temperature output range to be recorded can be set.

○Connecting method

IT-550L/S

＋�
－�

Analog voltage output cable

Recorder

Expansion box

５.１ Connecting the recorder

Modular cable
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Set the analog voltage output zero (lower limit) and full-scale (upper
limit) temperature.

If the ZERO set value is larger than or equal to the full-scale value, an error
output (approx. 1.5V) will be output.

Displaying ZERO
Press the  M  button several
times in the HOLD state to
display ZERO. "SET" blinks.

Changing ZERO
Figures can be changed with
the▼ or▲ buttons.

Displaying FULL-
SCALE
Press the  M  button one time
in ZERO state and display FS
value.
"SET" blinks.

Chapter 5

１

２

３

M ▼�

MEAS

▲�

■� /

M ▼�

MEAS

▲�

■� /

M ▼�

MEAS

▲�

■� /

Note:

５.２ Setting analog voltage output scale
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Changing FULL-
SCALE value
Figures can be changed with
the▲ or▼ buttons.

End setup
Pressing the  MEAS   button
ends setup.

４

５

M ▼�

MEAS

▲�

■� /

M ▼�

MEAS

▲�

■� /

Chapter 5
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TroubleshootingChapter 6

Symptoms

Data is not
transmitted to
personal
computer.

Printer does not
print.

Analog output is
not performed.

Causes

Battery of main unit is dead
or not loaded.

Cable is connected
incorrectly.

COM port is incorrect.

Communication port of
personal computer is set to
"Disabled."

"Memory data reading" was
selected on IT-550L/S.

Printer is not turned ON.

Cable is wrong.

Cable is not correctly
connected.

IT-550F is connected.

Setting of ZERO and FULL-
SCALE is wrong.

Range of recorder has a
different setting.

Countermeasures

Load new battery.

Connect the connector firmly.

Check that the RS-232C
cable connected to personal
computer is cross
connection.

Change COM port setting to another port
setting.
Set to COM1 or COM2 with the COM Port menu
in the Settings menu from the menu bar.

Change properties of
communication port in your
computer

Memory data cannot be read
as IT-550L/S has no data
memory function.

Turn ON the printer.

Use the correct cable.

Connect firmly.

IIT-550F is not equipped with
voltage output.

Make correct setting.

Set the recorder range to 0 to
1V.
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IT-550F (for Field use)

IT-550L/S (for laboratory use)

Reference Data

No. of maximum data

File operation

Printing

Screen

Statistics

Measured value judgment

Communication

Data No. 64,130 total

File reading, file writing (CVS format)

Data printing. Vertical and horizontal printing of A3, A4, B4, and B5 paper

Data No. table, data table, graph screen, and other various setting screens.

Maximum, minimum, average values

Comparison judgment of upper limit and lower limit

Memory data reading and setting of infrared thermometer 
measurement through RS-232C cable are possible.

No. of maximum data

File operation

Printing

Screen

Graph display 
function

Edit

Statistics

Communication

32,000 data x 8CH

File reading, file writing (CVS format)

Data and graph printing. Vertical and horizontal printing of A3, A4, B4, and B5 paper

Data CH table, data table, graph screen, real-time
measurement screen, other various setting screens

8CH simultaneous display, time axis, temperature axis
scale change and zooming
Two-cursor display, cursor data display, calculation of data
between cursors

Copying graph screen to clipboard

Maximum, minimum, average values

Setting of real-time measurement and infrared thermometer
measurement through RS-232C cable are possible.

Chapter 7

７.１ TEMP Utility specifications
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An operator who has a special knowledge of measurement using a personal
computer can transmit or receive the set values or measured values of the IT-
550 using the host computer.
Use the following specifications and communication method as a reference.
(1)RS-232C communication specifications
●Bits per second  :  2400
●Data bits  :  8                    Start,stop bits  :  1
● Parity  :  None
●Flow control by hardware:       CTS is valid when output to printer by

switch operation. CTS is ignored for other cases.
●Echo back:      ON/OFF switching possible. (OFF when power is ON)

(2)Communication method
When a valid command (+ operand) is received from the host computer
(refer to table below), the IT-550 transmits the response. It does not respond
to character strings that are not defined as a command.
● The IT-550 does not distinguish capital letters and small letters of

command and operand.
●When "]" is received, the IT-550 clears reception buffer and turns OFF

echo back.
●When "[" is received, the IT-550 clears reception buffer, turns ON echo

back, and returns "[".

７.２ Communication specifications

[ ]: Omission is possible. If omitted, present set value is returned.
xxx:    Figure of decimal system     rr:     "1" or "0.1"
note 1:         Function limited to IT-550F (Operation is not guaranteed for IT-550L/S.)
note 2:         Function limited to IT-550L/S (Operation is not guaranteed for IT-550F.)

Function
Measurement start, measured value request
Hold, measured value request
Emissivity setting

Clock setting
Year, month, day setting
Memory data request
Memory data clear

Measurement resolution switch setting
Analog output zero point setting
Analog output full-scale setting
Power OFF
Backup to non-volatile memoryﾟ

Command, operand
":" 
";"
"E [x.xx]"

"T [hh:mm:ss]"
"D [yy/mm/dd]"
"M"
"CLR"

"R [rr]"  
"Z [xxx]"
"F [xxx]"
"OFF"
"BKUP"

Response
Start message or instantaneous measured value
Hold message or hold value
Emissivity set value
Setting is valid only at holding.
Present time (see note 1)
Year, month, day (see note 1)
Memory data or "No Data" (see note 1)
Clear completion message or "No Data"
Valid only at holding (see note 1)
Measurement resolution (see note 2)
Output zero set value (see note 2)
Output full-scale set value (see note 2)
Power OFF message
Backup message

Chapter 7
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